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Before Class Resources 
 

Review Course Expectations 
 

• Recordings. Each session is recorded, and we have provided shorter videos for your later 
reference. Recordings automatically appear in the Posts panel inside the Sitecore 
channel after the meeting is concluded.  

 

• Questions and Interruptions. This class is for you, and we want to make sure your needs 
are met! Interruptions are encouraged. Please do not wait to let us know if you miss a 
step or have a question. You can unmute and speak, or you can use the Chat window.  

 

• Hands-On Practice. We feel that watching a demonstration is a poor substitute for 
hands-on practice, so we recommend participating in practice activities.  

 

• Course Duration. We cover all the essential information for using Sitecore and ask that 
you plan to stay for the duration of the course. If a conflict arises, we ask that you cancel 
and register for a different session.  

 

• Breaks. We will take two ten-minute breaks during the instruction but do make yourself 
comfortable with drinks or snacks and let us know if you need to step away sooner.  

 

• Course cancellations. If fewer than three people register, we will reschedule and alert 
you via email.  

 

• Two Monitors. We recommend using two monitors for training. Use your main screen 
for your browser to work in Sitecore. Use a second monitor to watch the demonstration 
in Teams. If you do not have a second monitor, split your screen between Teams and 
your browser. This course cannot be completed via mobile phone.  

  



Find the Training Team 
 
Sitecore training moves quickly, so we ask that you familiarize yourself with how to use Teams 
before coming to class. 
 
The course description for Sitecore on the OIT Training website includes a link to a step-by-step 
guide on how to find our team and join it. 
 
You must use the Teams desktop application for this class. 
 
You must enter the join code 6vtyzyw to become a member of the team. If you are not a 
member, you will not have a Chat, and will not be able to see information we post during class. 
 
 

Set Up Your Workspace 
 
We would like to provide you with suggestions for a great training experience.  Please take a 
moment to practice these techniques before class. 
 
 

Use Browser Tabs 
 
Sitecore is run entirely through your web browser.  You may use whichever browser you prefer.  
You do not need to be on VPN to use Teams or Sitecore.  
 
We recommend using tabs in your browser for easy access to materials we will use during class. 
 
1. Open the training instance of Sitecore in the first tab of your browser.   

(You will be given a username and password during class.) 
 

2. Open a second tab and go to https://www.lipsum.com/feed/html 
(Since our class focuses on learning how to use the tools themselves and not on authoring 
content, we use nonsense text known as Lorem Ipsum as a placeholder text.) 
 

3. Open a third tab and go to https://ds.web.uta.edu/ 
(The Design System website is your reference for Page Templates, Components, and more.  
It allows you to see what the item looks like, what its limits are, and more.) 

 
  

https://oit.uta.edu/_downloads/Using-Teams-for-Training-Instructions.pdf
https://oit.uta.edu/_downloads/Using-Teams-for-Training-Instructions.pdf
http://cms.training.web.uta.edu/sitecore/login
https://www.lipsum.com/feed/html
https://ds.web.uta.edu/


Adjust Screen Resolution  
 
We recommend using two monitors for training.  Use your main screen for your browser to 
work in Sitecore.  Use a second monitor to watch the demonstration in Teams. 
 
If you do not have a second monitor, split your screen in half between Teams and the browser. 
 
 
Increase your screen resolution to see more clearly in your browser or Teams. 
 

1. Click anywhere in the application window.   
2. At the same time, press CTRL on Windows or CMD on Mac and the Plus (+) key.   
3. This will make the text appear larger. 

 
 

Decrease your screen resolution to see items that may get cut off on smaller screens.   
 

1. Click anywhere in the application window.   
2. At the same time, press CTRL on Windows or CMD on Mac and the Minus (-) key.   
3. This will allow you to see you can see the hidden options.   

 
 

If something is still cut off in Sitecore: 

1. Hover over the edge of the window until directional arrows appear.   
2. Move the window around using directional arrows. 

3. Or, use the single arrow to stretch the window up or down.  
 
 
Reset your browser or Teams application to normal resolution: 
 

1. Click anywhere in the application window.   
2. At the same time, press CTRL on Windows or CMD on Mac and the Zero (0) key.   
3. This restores your screen resolution to 100%. 

 
 
  



Introduction 
 

File Trees, URLs, and Scaffolding 
 

File Tree 
 

• A file tree is a hierarchical structure used to build and organize pages on a website. 

• The turndowns and indentations indicate how many levels deep you are in the file tree. 

• The item name in the file tree generates the URL. 
 

URLs 
 

• Item names must include all lowercase letters and words should be broken with dashes. 

• The forward slashes in URL indicate how many levels deep you are in the file tree. 

• Breadcrumbs also reflect this relationship. 
 

Scaffolding Pages 
 

• A site scaffold is a build-out of blank pages that mirror the structure of the sitemap. 

• Creating blank pages you can link to allows you to build the Navigation in Site Data. 

• You can go back later and complete the design of each page. 
 

 
 



Sitecore Terminology 
 
A website is a collection of webpages. A webpage or page is a single entry on a website. 
 
Content is the text, images and data that appear on the webpage. 
 
A Page Template provides the overall structure for a webpage in Sitecore. We can think of it as 
the page frame for a house. It is the “skeleton” of the webpage with areas designed to hold 
specific types of content. A page template is empty until Components are built and added to it 
using Placeholders. 
 
A Wireframe is a sketch of a webpage. We can think of it as the blueprints for a house. The 
wireframes in the guide show the areas of each Page Template into which we can add 
Components, along with the Placeholders that cause them to display on the webpage. 
 
A Component an interactive element on a page.  Content is entered into a Component. 
 
A Rendering is the appearance of a Component or how it looks on the page. 
 
A Placeholder is the code that causes the Component to display on the page. Placeholders must  
be entered exactly, or the Component will not display. Placeholders are different for each Page 
Template. A Placeholder from one Page Template will not work on another.  
 
A Data Source is the Content entered into the Component. In Sitecore, we build Components, 
match them up to their correct Rendering, enter their correct Placeholder, and then associate 
the Rendering with the Data Source to cause the Component to display on the page. 
 
Navigation is the menu structure. All UTA sites have Site-Wide Navigation across the top of all 
webpages to provide a pathway to major sections of UTA.EDU. This navigation is the blue drop-
down menu that displays across the top and is editable by UA. 
 
Horizontal Header Nav is the navigation that displays below the Site-Wide Navigation for major 
sections of UTA.EDU such as departmental and staff group websites. Horizontal Header Nav can 
have a maximum of 8 top-level menu items. Page Templates such as Experience Landing with 
Nav and Detail Page use Horizontal Header Nav. (Detail Page uses Detail Page Nav, a combined 
component that pulls in Horizontal Header Nav and Interior Nav.) 
 
A Footer contains links and information that displays on all UTA.EDU webpages. It is editable by 
University Advancement only. 
 
A Prefooter houses the secondary and tertiary links for departments or staff pages. It displays 
above the Site-Wide Footer. It can hold information such as social media links, career or 
internship links, and contact information. 
 



Site Map is a list of all pages to plan the hierarchy and structure of the website. It is essentially 
an outline, with “levels” similar to how outlines are written for research papers. It also guides 
the naming structure (taxonomy) for URLs (the address of specific webpages.) 
 

Items to Take Note Of 
 

Quick Action Toolbar 
 
The Quick Action Toolbar allows you to easily view an item’s status in the Workflow.  These 
items should be checked in the Quick Action Toolbar:  My Locked Items, Locked Items, and 
Workflow State. 
 

 
 
To turn these items “on”: 
 

1. Open Content Editor in Sitecore 
 

2. Move your cursor to the far left of the file tree. 
 

3. Right click in the blank area to turn on the items shown at left. 
 
 

View Tab 
 
These items should be checked under the View tab:  Content Tree, Entire Tree, Standard Fields, 
Buckets. 
 

  
 
  



Rich Text Component 
 
Please note that the rendering for Rich Text is found under Foundation > Shared Layouts.  All 
other renderings are found under Feature.  
 

 
 

 

Detail Page 
 

• The Detail Page Nav component must be added to the page first or nothing else will 
display on the page. 
 

• Detail Page Nav causes Horizontal Header Nav and Interior Nav display together. 
 

• Some Detail Pages don’t show Interior Nav. This is achieved by unchecking “show in 
navigation” on the Interior Nav Header inside the Horizontal Header Nav component in 
Site Data. 

 
  



Content Editor 
 

Understand the Content Editor 
 
The Content Editor is divided into different panels that allow you to perform specific actions. 
 

• Ribbon – Add components to page; Preview work; Submit to workflow 
 

• File Tree – Build pages and components in Home or Site Data 
 

• Quick Action Toolbar – Easily view an item’s status in the Workflow 
 

• Content Panel – Enter information to appear on the page; Preview a Page 
 

• Bottom Toolbar – Switch between Content Editor, Media Library, and Workbox without 
losing your place. 

  



 
 
  



Basic Steps for Building Pages 
 
These steps are specific to the Home section only. 
 
1. Go to https://cms.prod.web.uta.edu/sitecore/login 

 
2. Sign in with Azure Active Directory. 
 
3. Open Content Editor. 
 
4. From the file tree on the left, click the karat   to open Content > UTA > Home. 
 

• The Home section is for creating components that get used once on a specific page. 
   

• Site Data is for any component or item (such as navigation and prefooters) that get used 
across multiple pages. 

 
5. Access webpages by scrolling through the file tree.  Click the karat   to open a section. 

 

• Academic units are found under Academics > Schools and Colleges. 
 

• Departments and staff groups are found under Administration. 
 
 
6. Open your folder by clicking the karat . 

 

• All of your group’s supporting pages will be stored inside your home page.   
 

• Some pages will have additional supporting pages, also known as subpages or “child” 
pages. 
 

• The forward slashes in the URL indicate how many levels deep you will find the page in 
your file tree.  For example: 

 
uta.edu/academics/schools-colleges/pop-culture/about 

 
  
  

https://cms.prod.web.uta.edu/sitecore/login


7. Next, add a new page.  Right click at the desired level and choose Insert. 
 

• To add a top-level page that will appear as one of the 8 menu items in your site’s main 
navigation, right click on your homepage and choose Insert. 
 
For example, to add an “About” page or another major top-level section, you will right 
click on your homepage and choose Insert. 
 

• To add a subpage inside of one of these sections, right click on the page name and 
choose Insert. 
 
For example, to add a page under “About” that is more specific, such as “about 
undergraduate programs” or “about graduate programs”, you would right click on 
“About” and choose insert.  This method places the new page at the appropriate level in 
the site structure. 

 
 
8. Next, choose the page template you want to use for the new page. 
 

• Homepages typically use Experience Landing with Nav.  This is a full-width page that 
includes navigation (Horizontal Header Nav) across the top.   
 
The icon for Experience Landing with Nav looks like this: 

 
 

• Most subpages use Detail Page. This page has a left rail and a main content area, along 
with the same navigation across the top (Detail Page Nav).  It also includes navigation at 
the top of the left rail (Interior Nav) that provides a pathway to subpages.  

 
The icon for Detail Page Nav looks like this: 

 
 

• Placeholders are the line of code that causes content to appear on a page.  Placeholders 
are not provided within Sitecore.  You must reference the Design System Website to get 
placeholders.   

 
  

http://ds.web.uta.edu/


 
9. Name the new page using all lowercase letters and no spaces. 

 

• Anything added in the file tree corresponds to your page URL.  
 

• Spaces in a URL will appear as %20 in the URL.  Dashes do not. 
 
IMPROPER:  uta.edu/academics/schools%20colleges/pop%20culture/about 
 
PROPER:  uta.edu/academics/schools-colleges/pop-culture/about 

 
  

10. Add a Page Content folder. Right click on the page name and choose Insert. 
 

• The Page Content folder is the container for every component you want to appear 
on your page.  Components contain the text, images, links, and buttons you wish site 
visitors to see.   

 

• A Page Content folder must be added after creating the page or the process will not 
work.  Each page will have its own Page Content folder.  All page folders should be 
named “Page Content.” 
 

• Choose Experience Landing with Nav Page Content Folder if using the Experience 
Landing with Nav page template. 

 

 
 
 

• Choose Detail Page Content if using the Detail Page page template. 
 

 
 

 

• Rename the folder to “Page Content.”   
 

 
 

  



 
11. Now you are ready to add components.  Right click on Page Content and choose Insert. 
 

• The Design System website outlines what components work on each Page Template, as 
well as defines the placeholders that go with it and allow it to be added to different 
sections of the page.  
 

• It also describes the use cases for each component, it’s limits, and an example of what it 
looks like.  

 
12. Build the component. Add content, images, links, buttons, et cetera and Save. 
 
13. Now you are ready to add the component to your page.   
 

• Reference “Add Components to Pages” to see the 16 steps you must follow to add the 
component to the page. Navigation should always be added first before any other 
components to the page.  If this is not done, nothing will display on the page. 
 

• Experience Landing with Nav uses Horizontal Header Nav. 
 

• Detail Page uses Detail Page Nav. Use only Detail Page Nav with Detail Page. 
 
  

http://ds.web.uta.edu/


Add Components to Pages 
 
1. From the file tree, select the Page to which you would like to add Components. 
 

• You must select the Page itself. 
 

• Do not select the Page Content folder or any of the Components. 
 

• The Page name and icon are highlighted in blue when selected. 
 

2. Click the Presentation tab. 
 
3. Click Details to view the Layout Details pop-up menu. 
 
4. Click the Final Layout tab. 
 
5. Scroll to the bottom of the list and click Edit to call up the Device Editor menu. 
 

You know you have done this properly if you see this in the Layout field: 
Layouts/Project/Website/Main Layout 

 
6. Choose the Controls tab. 
 

• There are many items in the list that power the site which you can ignore. 
 

• Organize Components between [Name of Page Template] and Footer. 
 
7. Click the Add button to call up the Select a Rendering menu. 
 
8. In the file tree, find the Feature folder and the Rendering that matches the Component. 
 

• There are many Components with similar names. 
 

• Renderings and Components must be matched exactly or this will not work. 
 
9. Select the Rendering you want.  Type into in the Add to Placeholder field. 
 
10. Check Open Properties Dialog Box Immediately to view the Control Properties menu. 
 

If you do not check this box, you can get back to the Control Properties for the Component 
by selecting it in the list and choosing Edit. 

 



11. Check that your placeholder is written correctly.  If so, under Data Source, choose Browse to 
call up the Select the Associated Content menu. 

 
12. Scroll to the bottom of the list, past Global Data and Site Data.  Look in the Page Content 

folder at the bottom to select your Component.  Click OK. 
 

• If your Component was built in Site Data, it will be located in that folder. 
 

• If a yellow banner appears at the top, something wasn’t done properly. 
 
13. This returns you to the Control Properties screen.  Click OK again to return to Device Editor. 
 

If you need to add more components, repeat steps 7-12. 
 
14. You will notice your Component automatically goes to the bottom of the Controls list. 
 
15. Click Move Up to move it between [Name of Page Template] and Footer. 
 
16. Move your Component up or down in the list in the order you want it on the site. 
 
17. Once you are done adding Components, click OK to return to Layout Details. Click OK again 

to return to the Content Editor. 
 
18. Choose Presentation then Preview to view your work in the same window.  

 
Or, choose Publish then Preview to open another browser tab. 

 
 
  



Use Workflows 
 

Steps for Content Author Role 
 

1. Open Content Editor and navigate to your section of the website. 
 

2. Find the component you wish to work on.  Lock and Edit to make changes. 
 

 
 

3. Make changes to the item. 
 

4. Select the Review Tab. 
 

5. Choose Submit to move the item from the Draft state to Awaiting Approval. 
 

 
  



6. Let the Content Approver know you have submitted work for their review. 
 
REMINDER:  At the end of the day, remember to go to the Review tab, choose My Items and 
select Unlock All to release all items so other users may access them. 
 

 
 
 

  



Steps for Content Approver Role 
 

1. Open Content Editor and navigate to your section of the website. 
 

2. Find the component you wish to work on.  Lock and Edit to make changes. 
 

 
 

3. Make changes to the item. 
 

4. Select the Review Tab. 
 

5. Choose Submit to move the item from the Draft state to Awaiting Approval. 
 

 
  



6. Add comments if desired and/or click OK. 
 

 
 

7. Lock and Edit the item again. 
 

 
 
 
  



8. From the Review tab, choose Approve.  (This action publishes the item to the live site. If 
you don’t want to publish to the live site, follow the steps to publish to Preview instead.) 

 

 
 
REMINDER:  At the end of the day, remember to go to the Review tab, choose My Items and 
select Unlock All to release all items so other users may access them. 
 

 
 
  



Steps for Approving Using the Workbox 
 
1. Open Workbox. 

 
2. Ensure UTA Workflow is checked at the top.  (Only the items that apply to your group will 

display in the workbox.) 
 

 
 
3. Expand the Awaiting Approval tab. 

 
4. Review the items to see what was changed. 

 
See the Comments to read notes from Content Authors. 

 

 
 
  



Click Open to view a snippet of Content Editor and scroll down to see the content entry 
fields that were changed.  

 

 
 
 
 

 
 
  



If you do not wish to interact with Content Editor, you may preview individual components by 
viewing the pages on which they appear.   
 
Select Preview to preview a page and all its components. 
 

 
 
5. Click the check box next to an item or several items. 

 
6. Scroll to the bottom of the page. 
 

• Choose Approve Selected to publish the item to the live site. 

• Choose Approve All to approve and publish everything in the list. 

• Choose Reject Selected to return the item to the Content Author for adjustment. 

• Choose Reject All to reject everything in the list. 
 

 
 

 
 
  



Publish to a Preview Page 
 
Users may wish to publish a webpage in Sitecore to a Preview target so that they may share the 
link with users who do not have access to Sitecore for their review and/or approval.  The steps 
below describe the process for publishing to a Preview target without affecting the live website.  
 
1. Select the Publish tab. 

 
2. Click the dropdown arrow next to the Publish button. 
 

 
 
3. Leave these checked:  Publish subitems, Publish related items, English, and Preview. 

 
4. Uncheck Internet under Targets.  This prevents publication to the live site.  
 

 
 
5. Check Preview under Targets to publish to the Preview site. 
6. Return to the page and view the Content panel. 

 
 



7. Expand the Quick Info tab. 
 

8. Find Item Path and copy the text that appears after Home/. 
 

 
 

9. Open a Text Editor program (TextEdit on Mac and Notepad on PC) and paste the text. 
 

 
 

10. Paste this text before the start of the copied text:  https://preview.prod.web.uta.edu/ 
 

 
 

11. Select all the text and copy it. 
 

12. Paste the text into a new browser tab and press enter to view the page. 
 

 
 

13. Paste the text into a chat, email, or other communication to provide a preview link to 
users who do not have Sitecore access. 

 

 



After Class Resources 
 

Use the Training Instance 
 
We use a Training Instance of Sitecore during class so that the real, live Sitecore is unaffected 
while we learn how to use it.  We call the real Sitecore “Prod,” as in “finished product.” 
 
We can make a practice area inside of the Training instance available to you after class if you 
wish.  Please let us know if this is something you’d like to have.   
 
Content built in the Training and Practice Instances cannot be moved to the Prod Instance.  
These are intended as practice areas only and are totally separate from Prod. 
 

Sitecore Support 
 
University Advancement is the group to contact for questions related to migration strategy, 
timelines, and governance.   
 
We offer Open Office Hours every other week at 10am on Wednesdays. Please utilize this 
forum to ask questions, troubleshoot issues, or provide feedback.  We also provide a live 
demonstration of specific components along with written documentation during this time.     
 
This meeting runs in the Posts tab of the Sitecore training channel.  A purple “Join” button will 
appear in the Posts tab of the Sitecore channel when the meeting is live.  
 

Use the Sitecore Training Instance After Class: 
 
1. Fill out the CMS Access form in Service Now to request access to Training-Practice. 
 
This is located at ithelp.uta.edu > Accounts & Access > Next > CMS Access 
 

2. Choose “Sitecore” 
 
3. “What is the URL of the site?” (Choose https://cms.training.web.uta.edu.) 
 
4. Choose “Approver” if you want the ability to practice publishing. (The training instance 
does not have a real publishing target, but you can go through the steps for practice.) 
 
5. Email Li-Wei or Farina and let them know what hours you’ll be working in it. 
 
The training instance is not turned "ON" all the time. 
 
You will need to let us know when you want to work in it so we can turn it "ON" for you. 

mailto:knowledgeservices@uta.edu
https://uta.service-now.com/selfservice2?id=utassp01_sc_cat_item&sys_id=f634d30a6f65660028232d65ad3ee437
https://cms.training.web.uta.edu/


 

Find Sitecore Resources 
 
We have provided information and resources inside the Sitecore channel.   
 
The Files tab contains the training guide, video tutorials and written documentation. 
 
We have pinned websites relevant to the Web Modernization project to the right of the Files 
tab.  You can view these websites inside of the Teams application, or you can open them in 
your web browser by clicking the Internet / Globe icon in the upper right.   
 
Click here to see a screenshot of the Sitecore channel. 
 

 
 
  

file:///C:/Users/waffa/Downloads/MicrosoftTeams-image%20(2).png


Request Access to Prod 
 
This course is designed for academic and business units that are in the process of migrating 
their public-facing content to Sitecore.  We recommend attending this training as close to your 
migration as possible so that the information is fresh. 
 
At the end of class, complete the CMS Access form in ServiceNow to request access to Prod.   
 
Your access request is cross-referenced with your registration on the OIT Training website.  If 
you did not register, we won’t be able to verify you attended. 
 
If you are not part of a migration wave yet, please do not request access until after your group 
has begun migrating to Sitecore. 
 

Log in to Prod 
 
“Prod”is the live instance of Sitecore. 
 
1. Go to cms.prod.web.uta.edu/sitecore/login 
 
2. Click “Sign in with Azure Active Directory” 
 
3. Enter your UTA NetID and password. 
 

Complete All Trainings 
 
Review the list of other required trainings on the Web Modernization website. 
 
Web Accessibility and Web Governance are delivered through Canvas.  They are asynchronous 
and you may work on them at any time.  There is a quiz at the end of each course. 
 
Knowledge Services also facilitates training on Cascade for internal-facing and operational 
content that will be moved to resources.uta.edu. We also offer training on CampusPress for 
research labs and centers. 
 
To learn programs like Adobe Photoshop, all UTA faculty, staff, and students have free access to 
LinkedIn Learning.  Visit https://oit.uta.edu/services/linked-in-learning/ for more information. 
 
Visit https://accessibility.uta.edu/ to learn more about accessibility and to set up a SiteImprove 
scan for your website. 
 
 
  

https://uta.service-now.com/selfservice2?id=utassp01_sc_cat_item&sys_id=f634d30a6f65660028232d65ad3ee437
https://webapps.uta.edu/oittraining/
http://cms.prod.web.uta.edu/sitecore/login
https://blog.uta.edu/redesign/toolkit/training/
http://resources.uta.edu/
https://oit.uta.edu/services/linked-in-learning/
https://accessibility.uta.edu/


Appendix 
 

Relevant Links 
 
Page Templates, Wireframes, and Placeholders:  https://ds.web.uta.edu/templates 
 
Component Library:  https://ds.web.uta.edu/components 
 
Tutorials:  https://ds.web.uta.edu/tutorials 
 
Files Tab of Sitecore Training Channel: Go to Channel 
 
Migration Toolkit: https://blog.uta.edu/redesign/toolkit/ 
 
Sitecore Best Practices: view document  
 
All WebMod Trainings: https://blog.uta.edu/redesign/toolkit/training/ 
 
PROD Instance: http://cms.prod.web.uta.edu/sitecore/login 
 
TRAINING instance:  http://cms.training.web.uta.edu/sitecore/login 
 
(The training instance is active during class and upon request only.  You will receive a username 
and password during class.) 
 
 
 

Support 
 
1. Review Video Tutorials for “bite-sized” videos of the material covered in Training. 
 
2. Review Component Tutorials for specific instruction on various components. 
 
3. Attend Bi-Weekly Open Office Hours in the Sitecore channel to troubleshoot and answer 

questions. Representatives from OIT Training, OIT Enterprise Development, and University 
Advancement attend each session to provide insight and support for your needs. 

 
4. Request individual support if necessary. 
 
  

https://ds.web.uta.edu/templates
https://ds.web.uta.edu/components
https://ds.web.uta.edu/tutorials
https://teams.microsoft.com/dl/launcher/launcher.html?url=%2F_%23%2Fl%2Fchannel%2F19%3A27784b33984c48df859f07de31210ec2%40thread.tacv2%2FSitecore%3FgroupId%3D0057f193-8a26-4ad7-b62b-0aaf5d56d4c8%26tenantId%3D5cdc5b43-d7be-4caa-8173-729e3b0a62d9&type=channel&deeplinkId=84b3b2fc-4990-4199-9806-a6bcad956388&directDl=true&msLaunch=true&enableMobilePage=true&suppressPrompt=true
https://blog.uta.edu/redesign/toolkit/
https://mavsuta.sharepoint.com/sites/WebModPhase2/Shared%20Documents/Forms/AllItems.aspx?id=%2Fsites%2FWebModPhase2%2FShared%20Documents%2FDepartment%20%2D%20Managed%2FMigration%20Toolkit%2FWeb%20Governance%2Fsitecore%2Dbest%2Dpractices%2Epdf&parent=%2Fsites%2FWebModPhase2%2FShared%20Documents%2FDepartment%20%2D%20Managed%2FMigration%20Toolkit%2FWeb%20Governance&p=true&originalPath=aHR0cHM6Ly9tYXZzdXRhLnNoYXJlcG9pbnQuY29tLzpiOi9zL1dlYk1vZFBoYXNlMi9FZFZUZ2ViNjdLWk9pd0pGZFFQNHZsMEJaMWs3MzdNMFEwNUNuOWhzbjRySWp3P3J0aW1lPWFmanpnWUl5MlVn
https://blog.uta.edu/redesign/toolkit/training/
http://cms.prod.web.uta.edu/sitecore/login
http://cms.training.web.uta.edu/sitecore/login


Accessibility Resources 
 
Content authors are responsible for ensuring webpages are accessible. 
 
EIR Accessibility website: accessibility.uta.edu 
 
Laura Hopkins, EIR Accessibility Coordinator: laura.hopkins@uta.edu 
 
SiteImprove runs reports on webpages to vet them for accessibility. 
 
Knowledge Base article on SiteImprove: kb.uta.edu/0010096 
 
 
 

https://accessibility.uta.edu/
mailto:laura.hopkins@uta.edu
file:///C:/Users/waffa/Desktop/kb.uta.edu/0010096
file:///C:/Users/waffa/Desktop/kb.uta.edu/0010096
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